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TIPS AutoCAD Raster Design 2009 Installation Instructions 
 

Getting Started  
 

 Before starting the installation process, you will need the following: 
 

 AutoCAD Raster Design 3D 2009 disk.  Note that the 2009 version is distributed 
on a DVD.   

 Serial number and environment variable information provided with the 
distribution. 

 A network shared folder (if creating a network deployment image).  This is the 
location where the deployment (i.e., Microsoft Installer Administrative Image) 
will be created.  It must be a network share with full access privileges.  The 
deployment image will take approximately 250 MB of disk space. 

 Approximately 20 minutes to create the deployment image; thereafter, 10 - 15 
minutes to install the program on each user machine (including verification of the 
installation and Service Pack update).  

 

General Overview  
 

1. Deployment Image (Recommended) - Although AutoCAD Raster Design 2009 can be 
installed directly on each client (i.e., user) machine, we recommend that a network 
deployment image be created and used for consistent installation.  The deployment image 
allows you to control what gets installed on the individual workstations, without having 
to configure each installation separately.  Once created, the image can be used for 
installation on user machines for the life of the software.  The deployment installs all files 
necessary to run the program on each user computer, and no communication with the 
image is required after the initial installation. 

2. Direct Install (Optional) - As an option, the software can be installed directly to user 
machines without creation of a deployment image.  This will require separate (i.e., 
repeated) configuration for each client installation.  The installation procedure is the same 
as that shown below under ‘Create a Network Deployment Image,’ minus references to 
deployment image name, directory location, and general deployment settings.   

3. All installations must be configured as “Network, Single License Server” license type. 
4. The environment variable ADSKFLEX_LICENSE_FILE must be set on each user 

machine according to the documentation provided in the software distribution package.  
Note that if a previous version of TIPS AutoCAD software was installed, the variable 
will already be set. 

5. Each user should open AutoCAD Raster Design 2009 at least once before installing the 
Service Pack and any associated software (e.g., Carlson Mining, etc.). 

6. Updates available at the time of this distribution can be found on the DVD in the Patches 
& HotFixes folder.  Note that the Solid Filled Object Hotfix is automatically applied if 
the TIPS distribution disk is used for installation.  Visit http://www.autodesk.com/support 
to check for current updates and service packs. 

7. If you have any questions or difficulties, contact Tom Mastaller at (412) 937-2108 or 
TMASTALLER@OSMRE.GOV; if Tom is unavailable, contact Tonya Buckmaster at 
(276) 523-0042 x13 or TBUCKMASTER@OSMRE.GOV.  

http://www.autodesk.com/support
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Insert the AutoCAD Raster Design 2009 Installation DVD 
• Insert the disk labeled AutoCAD Raster Design 2009 (If the setup does not start 

automatically, browse/navigate to ‘<DVD DRIVE>:\setup.exe' to initialize). 
 

 
 
• Recommended Installation:  Click Create Deployments.  This will initiate creation of a 

deployment image on a network drive.  The deployment image can then be used to install 
the software on any number of client (i.e., user) machines over the life of the software 
version.  Continue with Create a Network Deployment Image, below. 

 

 
 

• Optional Installation:  Click Install Products.  This will initiate direct installation of the 
software on the current user machine; installation configuration will have to be repeated 
for each user. 
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Create a Network Deployment Image 
 
• Specify (or “Browse” to select) a Network Directory location where the deployment 

image is to be created and later accessed for installation on user computers. 
• Specify a name for the deployment (e.g., Raster Design 2009 Network Deployment).  

This names the associated program shortcut for the deployment. 
• Click Next.   
• Note: This window is not applicable if using the direct install option  Proceed to next 

step. 
 

  
 
• Check the box next to ‘AutoCAD Raster Design 2009’ to include it in the deployment.  

The program requires approximately 230 MB of disk space on user computers, depending 
on configuration options. 

• Click Next to continue. 
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• Review license agreement and select (i.e., click in the circle next to) “I Accept” if 

acceptable. 
• Click Next to continue. 

 

 
 

• Enter the serial number provided with the software distribution. 
• Enter ‘TIPS’ as the First name; ‘OSM’ as the Last name; and, ‘USDOI’ as the 

Organization to identify the installation as a TIPS product.  
• Click Next to continue. 
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• Select the desired options for Log file and Silent mode installation.  The default options 

(as shown) are acceptable. 
• Click Next to continue.  
• Note: This window is not applicable if using the direct install option.  Proceed to next 

step. 
 

 
 

• Verify / select ‘AutoCAD Raster Design 2009’ as the product to be configured. 
• Click Configure to proceed. 
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• Click the circle next to ‘Network license’. 
• Select the license server model ‘Single License Server’. 
• Enter ‘TIPS’ as the name of the license server. 
• Click Next to continue. 

 

 
 

• You will get a warning that the server does not exist. 
• Click Yes to ignore the warning and continue. 
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• Verify / select ‘Typical’ as the installation type.  
• (If using the direct install option, there will also be a choice to create a desktop shortcut.) 
• Verify the install path.  The default ‘C:\Program Files\AutoCAD Raster Design 2009\’ is 

recommended. 
• Click Next to continue. (If using the direct install option, continue to the bottom section 

of page 9.) 
 

 
 

• This window allows for including additional files / folders as part of the deployment. 
• Click Next to continue. 
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• This window allows the inclusion of Service Packs as part of the deployment.  Service 
Pack 1 is included as part of the TIPS distribution (under the ‘Patches & Hotfixes’ 
directory on the DVD); however, Autodesk has advised that the service pack should be 
applied separately only after Raster Design 2009 has been installed and opened.  This 
procedure is incorporated in these instructions (page 16). 

• Click Next to continue. 
 

 
 

• It is recommended that ‘Enable live updates’ and ‘Enable Information Channels’ are 
selected; this ensures that users are made aware of program updates and issues. 

• ‘Enable CAD Manager Channel’ and ‘Enable RSS feeds’ are not necessary / 
recommended for the typical TIPS user. 

• Click Next to continue. 
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• Configuration settings shown are recommended for Access to Online Resources. 
• Click Next to continue. 

 

 
 

• This completes the configuration for AutoCAD Raster Design 2009. 
• Click Configuration Complete to continue. 
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• Review the settings to ensure that the configuration is as intended.  If settings need to be 
changed, you can go back through the settings by clicking on ‘Configure.’  If desired, you 
can also print the settings for your records. 

• If settings are correct, click Create Deployment to continue. 
• If using the direct install option, click Install; the installation should complete in 

approximately 5 minutes.  At that point click Finish and continue on to ‘Verify 
Installation / Network Licensing’ on page 13. 

 

 
 

• The deployment will now be created.  The process will rotate through several screen 
images as necessary files are copied to the deployment.  The process will typically take 
approximately 10 minutes. 
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• When the process has completed, note the links for product installation and deployment 

modification shown on the summary window. 
• Click Finish to complete the process and exit. 
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Install AutoCAD Raster Design on Client Machines 
 

• From the client machine, navigate to the directory that contains the Network Deployment 
Image (i.e., the network directory that was specified during creation of the deployment 
image (see page 3), and also noted in the step on page 11.). 

• Double click on the shortcut in this directory (shortcut was noted in step on page 11).  It 
will have what ever name you specified during creation of the deployment image (see 
page 3 and / or as noted in the step on page 11.). 

• Optionally, the shortcut can be copied to an alternate, more convenient location and 
accessed there; note that the network directory where the deployment was created is 
referenced by the shortcut and must be accessible for installation to proceed.  

 

 
 

•  Installation will begin and should take approximately 5 minutes to complete, depending 
on network connection and client machine speed. 

 

 
 

• Note that the status window will simply close (i.e., disappear) when installation is 
complete.  There will not be a “notice” that the installation was successful.  
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Verify Installation / Network Licensing 

 
• Have the user login and launch AutoCAD Raster Design 2009 from desktop shortcut or 

the Start Menu. 

 
 

or 
 

 
 

• If the ‘New Features Workshop’ window appears, select the circle next to ‘Maybe later’ 
to enable the user to be reminded of the New Features Workshop on the next program 
launch.  

• Click OK to continue. 
• If the ‘New Features Workshop’ window does not appear, it may have been turned off by 

the user in a previous session (just continue to the next step).  The ‘New Features 
Workshop’ can be accessed at any time from the program ‘Help’ menu. 
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• The program should open as shown below… 
 

 
 

• To verify that the client installation has performed properly, go to the ‘Image’ menu 
dropdown and click About Raster Design…. 
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• Click on the Product Information button. 
 

 
 

• Verify that the value for ‘License type’ is ‘Network’.  If the value is anything else, the 
installation did not perform properly and the licensing is not valid. 

• After verifying the settings, click Close. 
 

 
 

• Click on the ‘X’ in the upper right corner of the ‘About AutoCAD Raster Design’ 
window to close it. 

 
 
• Go to the ‘File’ menu pulldown and click Exit to close the program. 
• Proceed to the installation of Service Pack 1 (or more current Service Pack). 
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Install Service Pack 1 on Client Machines 
 
Service Pack 1 (i.e., SP1) was the latest available at the time of the TIPS software 
distribution and can be found on the distribution DVD in the Patches & HotFixes folder.  
 
Visit http://www.autodesk.com/support to check for more current issues.  Newer versions, if 
available, would be downloaded and installed as directed by Autodesk. 
 
• To initiate installation of SP1, browse/navigate to <DVD DRIVE>:\Patches & Hotfixes\ 

AutoCAD Raster Design 2009 Service Pack 1. 
• Double click on the appropriate ‘exe’ file. 
 - For 32-bit installations (most users), autocad_raster_design_2009_sp1_x86.exe 
 - For 64-bit installations, autocad_raster_design_2009_sp1_x64.exe 

 

 
 
• Installation will begin and should take approximately 1 minute to complete. 
• Click OK on ‘Installation Successful’ window to exit. 
 

 
 
 
 
 
 
 

http://www.autodesk.com/support
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• Optional Verification:  Verification that the service pack has been installed can be 

accomplished as done above for the main program (see pages 13-15, above). 
• In summary, open AutoCAD Raster Design 2009; select About Raster Design from the 

‘Image’ menu dropdown; then, click Product Information in the ‘About Raster Design’ 
window. 

• On the ‘Product Information’ window, verify that the value for ‘Product service pack’ is 
‘Service Pack 1’ (or later, if newer service pack is installed). 

• After verifying the settings, click Close. 
 

 
 

• Click on the ‘X’ in the upper right corner of the ‘About AutoCAD Raster Design’ 
window to close it. 

 
 

• Go to the ‘File’ menu dropdown and click Exit to close the program. 
 

• This completes installation of Raster Design 2009. 
• Other updates available at the time of this distribution can be found on the DVD in the 

Patches & HotFixes directory (i.e., <DVD DRIVE>:\Patches & Hotfixes\). 
• Note that the ‘Solid Filled Object Hotfix’ update contained on the DVD has been applied 

automatically if the TIPS distribution disk was used for deployment/installation;  there is 
no need to apply the hotfix separately. 

 
• Visit http://www.autodesk.com/support to check for the latest updates and service packs. 
 
• If you have any questions or difficulties, contact Tom Mastaller at (412) 937-2108 or 

TMASTALLER@OSMRE.GOV; if Tom is unavailable, contact Tonya Buckmaster at 
(276) 523-0042 x13 or TBUCKMASTER@OSMRE.GOV. 

http://www.autodesk.com/support
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